Enrich Your Web Modeling
Tools with Custom Forms

Stéphane Begaudeau - Obeo
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Me

e Software architect on Sirius Web

* 15 years of contribution in the Sirius ecosystem

e Acceleo
e EEF
* Sirius Desktop

e Sirius Web
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Sirius Web
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® 0 ® )X Sirius Web X 4+ v

<« > C ® localhost:5173/projects/cdf5f15b-0ebf-429a-b8bf-73c84e6791b8/edit/c0427a3¢c-52b0-4b33-ab7d-a9f0f97c74fd?selection=6d748870-4¢3f-4597-ac92-ff9b973885b8
)E( Papaya - Example  : > RUN COMMANDS... EX3
Sirius Web internal test project
‘|= *@ Explorer () Project Creation Lifecycle Diagram X = Details
+ ¥ & . SemanticDataCreatedEvent
| DR A< AvEHXTMCOCOGEWNT
> Tasirius Core Properties
v = Sirius Web - Lifecycle : Name e
v 1Y Sirius Web
€3 HTTP SemanticDataCreatedEvent
v L[5 Project Creation : Description

.(é'“. Project Creation Lifecycle Diagram
Description

v ¢ MutationCreateProjectDataFetcher

&3 HTTP

-0 CreateProjectlnput over HTTP Emitted By
@ IProjectApplicationService . - -
O- SemanticDataCreatedEvent over null © & Values o 4+ B -
> @ SemanticDatalnitializer
> @ ProjectSemanticDatalnitializer ~: 3, e gedion Listened By
f'fi'f C t P . t| t . channel S £ - —
@o Lreaterrojectinput  : AT -0 SemanticDataCreatedEvent over null = Values e 4+ B -
LS Application Layer -
> O3 Project
i Caused B
v Qs Semantic Data 4
> © ISemanticDataCreationService | ¥ ProjectCreatedEvent 3 Values > + B -
. v | &% Create ‘rojectinput ¢ > ¢ MutationCreateProjectDataFetcher
o SemanticDataCreatedEvent  : s - listened by \ ’ :
> s Project Semantic Data
call
@ IProjectApplicationService @ SemanticDatalnitializer ® ProjectSemanticDatalnitializer
>
calls calls calls
Ce Domain Layer
2= Ploject Qs Semantic Data Qs Project Semantic Data
@ IProjectCreation Service © ISemanticDataCreationService © IProjectSemanticDataCreationService
emils listened by me“s listened | by jamﬂs
o g 3

Learn more

Follow these links to view the code of this
Sirius Web internal test project on Github.
« Backend code

» Frontend code

React Flow

%  OBEO



Sirius Web

* Open source project of the Eclipse Foundation

 Web based modeling workbench

* Define your concepts

* Specify how to view and manipulate them

« Start working #

s OBEO



® 0 ® )X Sirius Web x B

« > @ ® localhost:5173/projects/0645ebcc-4455-4858-9b67-4ca264799de3/edit/d7db0110-7aca-4a9e-9898-d5149d60efa9?selection=9e60a5f6-0790-4f9d-baba-b32dalfaacds w £} 0

EZ Studio : > RUN COMMANDS... R +K|

*IZ "3 Explorer & Domain X = Details

Service
tEHe Q< Ay BHRMOCEN T

v E Domain

Core Properties
v & franklin —

&% Domain  : ()
v [ Project Service
name
description
- applicationConcerns
> domains [] Abstract

- iterations

Super Types
Valiioa e 4

]
<

v [C] ApplicationConcern O Project

HiRe, 2 Gescripion
- services T
-> controllers
v [[] Service
name
v [] Controller
name : [ ApplicationConcern [ Domain ] literation
v [) Domain : name [A] name name

done
name

- services

iterations [0..*]

applicationConcerns [0..%] domains [0..%]

v [] iteration

name

controllers [0..* services [0..* services [0..*
Biens [0.] [0. [0.]

> = View

AN

[ Controller [ service

name name
v

< Entity
Text
Boolean
(1 Number

OBEO



Bivi@it- 0@

=z [# Package Explorer X

|:)3 ContainingLink.java
L?g Contribution.java
I_?g Controller.java
Dg DataType.java
|_73 Domain.java
I?g Enum.java
D’g EnumLiteral.java
L?S Event.java
Dé‘ Folder.java
Dg FolderElement.java
[B GenericType.java
D'g Interface.java
Ug Interfacelmplementation.java
|_73 Iteration.java
Dg Link.java
D‘g Message.java
]?3 MessageEmitter.java
[_?3 Messagelistener.java
Dg ModelElement.java
|_?3 NamedElement.java
L]g Operation.java
I_!g OperationalActivity.java
[_73 OperationalActor.java
I?g OperationalCapability.java
I?g OperationalEntity.java
[)3 Operationalinteraction.java
OperationalProcess.java
I_Té‘ Package.java
D‘g PapayaFactory.java
D'g PapayaPackage.java
Efg Parameter.java
Dg Priority.java
Ef'g Project.java
DS ProvidedService.java
I?g Publication.java
Dg Query.java
I—!g Record.java
Dg RecordComponent.java
I?g ReferencingLink.java
l_?g Repository.java
I_?g RequiredService.java
L?g Service.java
D'g Subscription.java
I?g Tag.java
E@ Task.java
Dg Type.java
L]'g TypedElement.java
I?S TypeParameter.java
[ visibility.java
H% org.eclipse.sirius.components.papaya.impl
E% org.eclipse.sirius.components.papaya.spec
Hg org.eclipse.sirius.components.papaya.spec.derived
Eﬁ org.eclipse.sirius.components.papaya.util
v Q% src/main/resources
v [y model
i papaya.ecore
[t papaya.genmodel
=\ JRE System Library [JavaSE-17]
=\ Maven Dependencies
{#% src/testfjava
@target/generated-sourceslannotations
(#% src/test/resources
& target/generated-test-sources/test-annotations
[ src
= target
s} pom.xml
E:d pom.xml.versionsBackup
@ sirius-components-papaya.iml

VvV V V V V V V V V V V V V V V VV V VVVV VYV VYV YV VYV VLV VYV VYV VYV VLV VVVYVYVYVVYVYVYVYV

vV VvV VvV VvV

> Hsirius-components-papaya-edit [sirius-web sbe/enh/papaya-fix]

Selected Object: Project -> NamedElement, Container

2 M CA- = AF

spring-tools-for-eclipse - sirius-components-papaya/src/mainfresources/model/papaya.ecore - Spring Tools for Eclipse

M@ B

ES 8§ = O

C_] papaya.ecore X @ papaya.genmodel
v i_l platform:/resource/sirius-components-papaya/src/main/resources/model/papaya.ecore
v papaya

> E| ModelElement

> HTag

> [ Link

> ReferencingLink -> Link

> [ ContainingLink -> Link

> k] NamedElement -> ModelElement

> [ Container

|5 Folder -> NamedElement, Container
[] FolderElement

> B Project -> NamedElement, Container

> [ OperationalCapability -> NamedElement, FolderElement

E} OperationalEntity -> NamedElement, FolderElement
> [ OperationalActor -> NamedElement, FolderElement

|-} OperationalProcess -> NamedElement, FolderElement
> [ OperationalActivity -> NamedElement, FolderElement

> [ Operationalinteraction -> NamedElement

1 Instant [java.time.Instant]
> [ Iteration -> NamedElement, FolderElement
> [ Task -> NamedElement, FolderElement
> 2 Priority
Contribution -> NamedElement, FolderElement
Component -> NamedElement, FolderElement
ComponentPort -> NamedElement
ComponentExchange -> NamedElement
ProvidedService -> NamedElement
RequiredService -> NamedElement
Visibility
AnnotableElement

Type -> NamedElement, AnnotableElement
TypedElement -> NamedElement, AnnotableElement
GenericType -> ModelElement, AnnotableElement
Annotation -> Type
AnnotationField -> TypedElement
Classifier -> Type
TypeParameter -> NamedElement
Interface -> Classifier
| Interfacelmplementation
Class -> Classifier, Interfacelmplementation
Constructor -> AnnotableElement
—| Attribute -> TypedElement
[£] Operation -> TypedElement
[l Parameter -> TypedElement
> E} Record -> Classifier, Interfacelmplementation
Ej RecordComponent -> TypedElement
[ DataType -> Type
> [ Enum -> Type
|-} EnumLiteral -> NamedElement, AnnotableElement

|

vV V V V V VV VVV V V.YV
o
¢

(I 0D 0D 0T 07 00 00 00 00 01 01 0D 00 00w

v

>
>
>
>
>
>

> E} ApplicationConcern -> NamedElement, FolderElement
[ Controller -> NamedElement, MessageEmitter, MessagelListener

>
> [ Domain -> NamedElement, FolderElement
>

E] Service -> NamedElement, MessagelListener, MessageEmitter

LQ Problems @ Javadoc @ Declaration L’??J Git Repositories [_| Properties X

Property Value
Abstract v false
Default Value =
ESuper Types £l NamedElement -> ModelElement, Container
Instance Type Name '=
Interface lv false
Name 1= Project

: | OZ

hifl] B

og

Package -> NamedElement, AnnotableElement, FolderElement

elele}
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Forms

 Form description
 Same philosophy as diagrams
* | everaged in various parts of Sirius Web

 Form representation, Details view, Related Elements view, Model
Browser, Diagram Filters...

s OBEO



Forms Java API

Low level
Easier integration with existing frameworks
Can be used for complex use cases

Higher performance celling

s OBEO



Forms Java API

Function<VariableManager, String> labelProvider = variableManager — variableManager.get(VariableManager.SELF, Object.class)
.map(object — "Form " + this.labelService.getStyledLabel(object).toString())

.0rElse(null);

var formDescription = FormDescription.newFormDescription("Custom Form Description")
.Label("Form description")
.idProvider(idProvider)
.labelProvider(labelProvider)
.targetObjectIdProvider(targetObjectIdProvider)
.canCreatePredicate(variableManager — true)
.pageDescriptions(pageDescriptions)
.iconURLsProvider(variableManager — List.of())

Lbuild();

s OBEO



Forms View DSL

Ease of use
Higher level of abstraction
Default values

Expression based configuration thanks to AQL

s OBEO



Forms View DSL

new FormDescriptionBuilder()
.name ("Form")
.titleExpression("aqgl:'Form ' + self.label()")
.domainType("domain:Domain")
.preconditionExpression("aql:true")
.pages(pageDescription)

Lbuild();

s OBEO



Java APl vs View DSL

Function<VariableManager, String> labelProvider = variableManager — variableManager.get(VariableManager.SELF, Object.class)
.map(object — "Form " + this.labelService.getStyledLabel(object).toString())
.orElse(null);

titleExpression("aqgl:'Form ' + self.label()")

s OBEO



€ @ )7 Sirius Web X + v

< > C ® localhost:5173/projects/0046e224-9281-43c5-9d2c-3558b6be4dce5/edit?selection=747c2¢c28-4886-4efe-af62-64029cc2e0fa phd N @

j*:( Studio : > RUN COMMANDS... @

®& ™& Explorer = Details
* ? = & Elements B
: Create a new Model
v Taview : Select the model to create Coks Pigperles |G
v © View
3 Domain
v [F] Papaya Form Name &
v B0 Main Page e Elements
v @& Core properties
> Tr Name Label Expression
> A Description Elements

Create a new Representation
& Homepage .
- Select the representation to create Help Expression
v am Contents
laa) Portal

:= Elements The elements of the project

i= Folders
Diagnostics Expression

Minr atine Evnaranoinr
D1agnoslIiCS EXpPression
~/ ]

Open an existing Representation
Select the representation to open

Value Expression

aql:self.elements

Display Expression

agl:candidate.name

Is Deletable Expression

false

Is Enabled Expression

le Enahlad = rocoinm
S Enabled LX},)r\';ts,‘ul(_/I.




Button
Checkbox
Date / Time
Image
Label

Link

List

Multi select

Radio

Widgets

» Reference
* Rich text

o Slider

e Select

e Split button
* Jext area

o Textfield

e Tree

e And more...

/

OBEO



Custom Widgets

* You can contribute your own widgets
* View definition for specifiers
 Backend behavior
 Frontend appearance and behavior

 Multiple examples in the Sirius Web project like the reference widget

s OBEO



Rendering

View Form Description Java Form Description

Business Data

% OBEO



@ © @ LY Sirius Web x BT :

< > C ® localhost:5173/projects/cf307e9e-a5bc-4754-a483-c03043c9f805/edit/2b81bc93-6b92-43fa-bf94-6fb5d773e80a?selection=781da8b8-258e-4f57-93d2-712a2b027a7f w £} e

)37 Papaya ! > RUN COMMANDS... &

Sirius Web internal test project

®= "3 Explorer [E] Newform X = Details

3z o _ = . %
+ f - Core proper“es S|rlus—components-representatlons °<>° @ ’

vEPapaya : Name (@ @

Core Properties
v {1} Sirius Web Project p

Sirius Web Project i
ame )

[E] New form

[ Data : Description @ sirius-components-representations

3 Requirements = T = = B I < S

[ Specification Description

& sirius-components-core  : An open-source low-code platform for defining custom web applications that support your specific visual languages = T = = B I <« &

& sirius-components-representations

o Graphically represent and edit data -
& sirius-components-diagrams Description

& sirius-components-forms ~ : o With a modern cloud-based application
Dependencies
o No Desktop Installation Required Values cee -
Used As Dependency By
Contents
None
Elements (@
& sirius-components-core Additional Information
&  sirius-components-representations All Dependencies
& sirius-components-diagrams None
& sirius-components-forms All Components
Folders (@ None
(O Data

(3 Requirements

[0 Specification




@ LY Sirius Web X + v

< C ® localhost:5173/projects/cf307e9e-abbc-4754-a483-c03043c9f805/edit/2b81bc93-6b92-43fa-bf94-6fb5d773e80a?selection=781da8b8-258e-4f57-93d2-712a2b027a7f W i} @ :

Papaya : > RUN COMMANDS...

Sirius Web internal test project

*I= "3 Explorer E] Newform X = Details =

Core properties sirius-components-representations & D

v E Papaya : Name @
v {aY Sirius Web Project

Core Properties
Sirius Web Project

N
[F] New form ame
[ Data : Description @ sirius-components-representations
[ Requirements : T = =

Description

[ Specification
& sirius-components-core  : An open-source low-code platform for defining custom web applications that support your specific visual languages

ogo sirius-components-representations

o Graphically represent and edit data DG ARG

& sirius-components-diagrams

& sirius-components-forms ~ : o With a modern cloud-based application
Dependencies

]
<

o No Desktop Installation Required cee

Used As Dependency By
Contents

None
Elements (®
& sirius-components-core Additional Information
& sirius-components-representations All Dependencies
& sirius-components-diagrams None
& sirius-components-forms All Components
None

Folders (®
[0 Data

(O Requirements

(O Specification

v, OBEO



LY Sirius Web X -+ v

< C ® localhost:5173/projects/cf307e9e-abbc-4754-a483-c03043c9f805/edit/2b81bc93-6b92-43fa-bf94-6fb5d773e80a?selection=781da8b8-258e-4f57-93d2-712a2b027a7f w T} G :
Papaya : > RUN COMMANDS...
Sirius Web internal test project
*Is "™@ Explorer E] Newform X = Details =
+ * & Core properties sirius-components-representations & D
v EPapaya : Name @@

- . Core Properties
v ) Sirius Web Project Sirius Web Project

N
[F] New form ame
[ Data : Description @ sirius-components-representations
[ Requirements  : T = =

Description
3 Specification P

& sirius-components-core  : An open-source low-code platform for defining custom web applications that support your specific visual languages &= T = = B I < <
& sirius-components-representations _ _
o Graphically represent and edit data Basarinn
& sirius-components-diagrams PRGIANON
(%
& sirius-components-forms ~ : o With a modern cloud-based application
Dependencies
o No Desktop Installation Required e+ ~
Used As Dependency By
Contents
None
Elements (®
& sirius-components-core Additional Information
& sirius-components-representations All Dependencies
&  sirius-components-diagrams None
& sirius-components-forms All Components
None
Folders (®

[0 Data

(O Requirements

(O Specification

v, OBEO



LY Sirius Web X 5 v

< C ® localhost:5173/projects/cf307e9e-abbc-4754-a483-c03043c9f805/edit/2b81bc93-6b92-43fa-bf94-6fb5d773e80a?selection=781da8b8-258e-4f57-93d2-712a2b027a7f W T} G :
Papaya : > RUN COMMANDS...
Sirius Web internal test project
*Is "& Explorer E] New form X — Details =
+ * & Core properties sirius-components-representations & D
v E Papaya : Name (@

- . Core Properties
v ) Sirius Web Project Sirius Web Project

N
[F] New form ame
[J Data : RascEiptien sirius-components-representations
[J Requirements  : T ’ B I <« <

Description

[ Specification

& sirius-components-core  : An open-source low-code platform for defining custom web applications that support your specific visual languages = T = = B I < <
& sirius-components-representations _ _
o Graphically represent and edit data Basarinn
& sirius-components-diagrams ExcHon
(%
& sirius-components-forms ~ : o With a modern cloud-based application
Dependencies
o No Desktop Installation Required e+ ~
Used As Dependency By
Contents
None
Elements (@
&  sirius-components-core Additional Information
& sirius-components-representations All Dependencies
&  sirius-components-diagrams None
& sirius-components-forms All Components
Non
Folders (@ one

[0 Data

(O Requirements

[0 Specification

v, OBEO
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Dynamic Mappings

* Create multiple widgets at once

e |teration and condition

s OBEO



€ @ )7 Sirius Web X + v

< > C ® localhost:5173/projects/0046e224-9281-43c5-9d2c-3558b6be4dce5/edit?selection=9e11b46a-cec6-47d8-85a9-a3b747a4d393 Dk ¢ N @

j*:( Studio : > RUN COMMANDS... @

®& ™& Explorer = Details
+ ? - & lterations >
Create a new Model
v Vi :
E: o Select the model to create Core Properties |E|
v © View
A D H
v [F] Papaya Form Qe Name =
> B Main Page : —— Iterations
v B Planning
Iterator

v o lterations

v lterations : i iteration
2 Create a new Representation
> Tr Name

Select the representation to create

Iterable Expression

L Faltal aql:self.elements->filter(papaya::lteration)

Open an existing Representation
Select the representation to open




& @ )7 Sirius Web X =+ v

< > C ® localhost:5173/projects/cf307e9e-a5bc-4754-a483-c03043c9f805/edit/2b81bc93-6b92-43fa-bf94-6fb5d773e80a?selection=2b81bc93-6b92-43fa-bf94-6fb5d773e80a YA ) @

j*:( Papaya : > RUN COMMANDS... Q

Sirius Web internal test project

.l= *@ Explorer [E] New form X — Details
2 o

T % € Main page Planning New form >
v ‘B= Papaya []
i Core Properties |Ls

v () Sirius Web Project Iterations p
[E] New form Name e (e}

(3 Data lteration 2025.8.0 New form

[ Requirements — Documentation

[ Specification

oh s Iteration 2025.10.0 Documentation
& sirius-components-core  :

ogo sirius-components-representations Name Description Name Papaya Form

ogo sirius-components-diagrams Iteration 2025.12.0

& sirius-components-forms

5] lteration 2025.8.0
5] lteration 2025.10.0
5] lteration 2025.12.0




WYSIWYG

* View based form descriptions have a WYSIWYG editor

* Build your form graphically

s OBEO



€ @ )7 Sirius Web X + G

< > C ® localhost:5173/projects/0046e224-9281-43c5-9d2c-3558b6bedce5/edit/d86dad24-2a24-43a5-8bb1-78dc2b643f66?selection=7d543aa9-4b0b-4d10-83d0-9520eb1d74a5 w I} 6

j*:( Studio : > RUN COMMANDS... @

'l= "3 Explorer [ FormDescriptionEditor X — Details
+ * T & Form Name >
v T View : Pages
BN 9 Main page Planning Drag and drop a page here + Core Properties @
v iew
= Name
v [E] Papaya Form Page (€]
e : A
[ FormDescriptionEditor : Core properties i Name
Groups
v B Main Page P
Label Expression
v & Core properties  : = el O P
> Tr Name : Group Lorem ipsum dolor sit amet, consectetur adipiscing elit Name
> A Description : Controls e
Description @ Help Expression
G Homepage O
> & Contents . = T = = B I <« ¥ The name of the project
v B Planning
. Diagnostics Expression
: . -
v & lterations : :' RlCh teXt document
! 5 ; o
v O lterations : Your rich text. aql:if self.name.size() = 0 then
i uence{'Error: The name is required'
> Tr Name Widgets Seq { e q }
View on Github else
ils Sequence{}
Bar Chart _
e Drag and drop a widget here
Value Expression
) . J
Button aqgl:self.name
/ )
Contents - g Is Enabled Expression
Checkbox i - :
Elements (® Is Enabled Expression
DateTime A Value 1 [}
i B value 2 [ ]
Flexbox
Container
B value 3 [ ]




@ @ LY Sirius Web X + v
< C ® localhost:5173/projects/0046e224-9281-43c5-9d2c-3558b6bedce5/edit/d86dad24-2a24-43a5-8bb1-78dc2b643f66?selection=f1a71f24-05fc-40f9-a1d8-c7bf82b5270d Dk g D @ :
Studio : > RUN COMMANDS...
*Is "I@ Explorer [[H FormDescriptionEditor X — Detalils o
+ * = & Form Planning
'E: o 9 Main page Planning Drag and drop a page here + Core Properties
v iew
E Name
v [F] Papaya Form
Page -
[[d FormDescriptionEditor Iterations Planning
Groups ,
v B Main Page P
v S Core properties = kor iteration in aql:self.elements->filter(papaya::lteration) Label Expression
> Tr Name : Group Naitiie Planning
> A Description : Controls . " e X
Lorem ipsum dolor sit amet, consectetur adipiscing elit DiiEl TV
G Homepage : \(_) = e r 2
rag and drop a widget here e
> aa Contents For 9 P 9 papaya::Project
v B Planning ; The element description "papaya::Project" does not have a valid domain
. Drag and drop a widget here
v B lterations N class
If J
v O lterations : Semantic Candidates Expression
> Tr Name : Widgets
i A RURRRE. S aql:self
Drag and drop a group here
ils
Bar Chart Precondition Expression
3 |
Button

Checkbox

)

DateTime

Flexbox
Container

% OBEO



22( Studio : > RUN COMMANDS...

*I3 "I& Explorer [ FormDescriptionEditor X — Details
+ & F & Form Main Page >
v g View : Pages
. 9 Main page Planning Drag and drop a page here Y Core Properties IQ
v iew
= Name e
v [5] Papaya Form 5
2 4 : ) ;
[[H FormDescriptionEditor : Core properties 4 Main Page
Groups
> BED Main Page P
Label Expression
v B Planning = Name ® B
v S jterations Group Lorem ipsum dolor sit amet, consectetur adipiscing elit Main page
v O lterations : Controls -
Description (@ Domain Type
> Tr Name : O
= = T = = B I <> & papaya::Project
The element description "papaya::Project" does not have a valid domain
J -
< Rich text document clase
Your rich text. Semantic Candidates Expression
Widgets
View on Github aql:self
1
Bar Chart . ition E ;
ar Char Drag and drop a widget here Precondition Expression
3 \_ ) Precondition Expression
Button k
. I
Contents _ & 4
Checkbox
Elements ®
DateTime ! Value 1 B
o B value 2 [ ]
Flexbox
Container
B value3 []
. N

%.. OBEO



Layout

* There are multiple options to change the layout
* Flexbox container widget
 Group style

e Specific widget style like Textfield

s OBEO



"

®® Explorer

v E: Papaya

v 1{a) Sirius Web Project

[E] New form

[ Data

(3 Requirements

[ Specification

ogo sirius-components-core

ogo sirius-components-representations
ogo sirius-components-diagrams
& sirius-components-forms

5] lteration 2025.8.0

[5] Iteration 2025.10.0

5] Iteration 2025.12.0

= |

[F] New form X

Main page Planning

Iterations

Name

Ilteration 2025.8.0

Papaya :

Sirius Web internal test project

> RUN COMMANDS...

— Details

New form

Core Properties

Label

New form

Start Date

23/06/2025 09:00 0

End Date

13/08/2025 17:00 O

Name

lteration 2025.10.0

Documentation

Start Date

18/08/2025 09:00 O

End Date

08/10/2025 17:00 0

Name

lteration 2025.12.0

Start Date

13/10/2025 09:00 0

End Date

03/12/2025 17:00 0

Description Name Papaya Form

%.. OBEO



"

®® Explorer

| v E: Papaya

v () Sirius Web Project

[E] New form

[ Data

[ Requirements

[ Specification

ogo sirius-components-core

ogo sirius-components-representations
ogo sirius-components-diagrams

& sirius-components-forms

5] lteration 2025.8.0

[5] Iteration 2025.10.0

5] lteration 2025.12.0

|

Papaya :

Sirius Web internal test project

[F] New form X

Main page Planning

Core properties

Name (@

Sirius Web Project

> RUN COMMANDS...

— Details

New form

Core Properties

Label

New form

=

Description (@

T = = B I < &

An open-source low-code platform for defining custom web applications that support your specific visual languages

o Graphically represent and edit data
o With a modern cloud-based application

o No Desktop Installation Required

View on Github

Contents

Elements (@

&  sirius-components-core

&  sirius-components-representations
& sirius-components-diagrams
& sirius-components-forms
]  lteration 2025.8.0
Bl lteration 2025.10.0
Bl lteration 2025.12.0
Folders (@
[0 Data

[0__Requirements

Documentation

Description Name Papaya Form

%.. OBEO



& @ ) Sirius Web X =+ v

< C ® localhost:5173/projects/cf307e9e-a5bc-4754-a483-c03043c9f805/edit/2b81bc93-6b92-43fa-bf94-6fb5d773e80a?selection=42d44927-f8a2-4299-af24-a5b2bcab2a40 w ) 6

)2( Papaya : > RUN COMMANDS...

Sirius Web internal test project

& Related Elements

*I= "™ Explorer

[E] New form X

t * € Main page Planning [ ¢ INCOMING = <+ CURRENT = —> OUTGOING ]
v E: Papaya Incoming
v () Sirius Web Project Core properties > & Elements
[] New form : Name @
[J Data : Sirius Web Project Current

[ Requirements v [3O Parent
(@ Sirius Web Project

3 Children

Description (@
[ Specification

L T B E B I <« $
&P sirius-components-core

ogo sirius-components-representations

An open-source low-code platform for defining custom web applications that support your specific visual languages
ogo sirius-components-diagrams P P g PP pporty P guag

& sirius-components-forms  : o Graphically represent and edit data Outgoing

5] Iteration 2025.8.0

None

[5] Iteration 2025.10.0 o With a modern cloud-based application

(5] Iteration 2025.12.0  : o No Desktop Installation Required

View on Github

ELEMENTS FOLDERS - -

Elements (@ Folders (@
& sirius-components-core (3 Data
& sirius-components-representations [0 Requirements
& sirius-components-diagrams [0 Specification

& sirius-components-forms
(5 Iteration 2025.8.0

(5 Iteration 2025.10.0

Bl Iteration 2025.12.0




Style

* Various properties can be configured on most widgets
 Font size
 |talic, bold, underline, strikethrough
 Background and foreground color

» [Label vs widget position, gap, ...

s OBEO



22( hepayas > RUN COMMANDS...

Sirius Web internal test project

*Is " Explorer [E] Newform X = Details
o -
, T € Main page Planning Charts New form | 2
\ E: Papaya Q
v 13) Sirius Web Core properties Core Properties [La
[F] New form : Name @ -abe! ()
[ Data : Sirius Web New form
[ Requirements i
| Description (@ Documentation
[ Specification ) |
= T = = B I <> < Documentation

ogo sirius-components-core

& sirius-components-representations

S , An open-source low-code platform for defining custom web applications that support your specific visual languages
&P sirius-components-diagrams

Description Name Papaya Form

& sirius-components-forms o Graphically represent and edit data

5] Iteration 2025.8.0
[5] Iteration 2025.10.0 o With a modern cloud-based application

(5] Iteration 2025.12.0 o No Desktop Installation Required

View on Github

ELEMENTS FOLDERS - -

Elements (@ Folders (@
& sirius-components-core [0 Data
& sirius-components-representations [0 Requirements
& sirius-components-diagrams (O Specification
& sirius-components-forms
A (5 Iteration 2025.8.0
(5 Iteration 2025.10.0
] Iteration 2025.12.0

%.. OBEO



Representation composition

o Sirius Web representations are based on a common rendering engine
 Use concepts of Element, Component and Props like in React

 Made to share some concerns between representations

s OBEO



Representation composition

 [wo strategies
 Frontend composition -> two subscriptions

 Backend composition -> a single subscription
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SW sirius-web 79 sbe/enh/workbench-api SiriusWeb v

() (@ IComponent.java : (@ IProps.java ~ : N
—o— * = 2 Y3 A v V... / > 3¥3 A v &
* (@author sbegaudeau package org.eclipse.sirius.components.representations;
D * (@since v0.1.0 m
*/ import
8% @PublicApi A& Stéphane Bégaudeau +1 @
@, public interface IComponent { /**
I:g VAL * Common interface used by all the properties of the components.
* Used to compute dynamically new elements to be rendered for the representation. *
m * * <p>
* <p> * This interface is a Java based port of the same concept in the JavaScript framework React.
oo * Just like in React, a component can return only one top level element. * It is used to provide a set of properties to {@link Element elements} whether they are regular el
* In order to return multiple elements at once from a component, a {@link Fragment fragment} ca@ * {@link ICompop~r=+ n~nmnanan Fel
* encapsulate multiple elements at once. *x </p> [©]) org.eclipse.sirius.components.representations
*x </p> * @PublicApi
* * <p> public interface IProps
* (@return The element computed by the component * Each component nature.
%/ * Just 1like in | Common interface used by all the properties of the components. he compositid
44 @ Element render(); 62implementations & Pierre-Charles David * </p> This interface is a Java based port of the same concept in the JavaScript framework
} * React. It is used to provide a set of properties to elements whether they are regular
x {@snippet id="proj elementsor components .
© Element java * const Component = Each component and element will have a dedicated props which will be used as its
= b B © ® return ( signature. Just like in React, the special props children is used to perform the
[*% - - * &Llt;elemer composition of elements
* The building block of the virtual data structure used to create the representations. * {chilc
. : st /eionl const Component = ({ someProperty, children }: ComponentProps) => {
return (
* S8 * ); <element someOtherProperty={someProperty}>
* Elements are directly inspired by the element API from the JavaScript framework React. x } {children}
* They provide a generic building block to build an immutable tree based data structure. - * F . </element> U
* /D> Il % ; e
O\ x * @author sbegaudeat
. * @author sbegaudeau « @since vO.1.0 Since: vO0.1.0
< * [@since v0.1.0 %/ Author: sbegaudeau
@ */ . . ERUBLIchpl. & Plorro Gy g sirius-components-representations 7
@PublicApi & Stéphane Bégaudeau +1 48 @  public interface IProps {
® 31 @  public class Element {
private Object type; 2 usages /%
* Provides the way to compose elements into a tree based structure for the rendering.
private IProps props; 2 usages *
@ * @return The child elements
public Element(Object type, IProps props) { 2 Pierre-Charles David */
v this.type = Objects.requireNonNull(type); @) default List<Element> getChildren() { 38overrides & Pierre-Charles David
O sirius-web > packages > core > backend > O sirius-components-representations > src > main > java > org > eclipse > sirius > components > representations > (© Element 31:114 LF UTF-8 4spaces &

v.. OBEO



Charts

<) ® L Sirius Web x R
< > C ® localhost:5173/projects/0046e224-9281-43c5-9d2¢c-3558b6bedceb/edit/d86dad24-2a24-43a5-8bb1-78dc2b64 3f66?selection=6774fa2f-fdb0-44e0-a3ad-b861d1d53a0f bk g 8
)E( Studio > RUN COMMANDS... % +K
*I3 " Explorer [EH FormDescriptionEditor X = Details
+ * Form Types
v View
t= - Pages < page Planning Charts Drag and drop a page here Core Properties
v ew
/| Name
v [Z] Papaya Form Page
-
[E@ FormDescriptionEditor Charts Types
> B Main Page s
> B Planning = Types Label Expression
v B Charts Grovp Types
v =& Charts Controls 70-
= 65-69 Help Expression
G Types S 14,547,446
il Types 60-64 . Help Expression
For 18,415,681 e
2 55-59 g}f%’ Diagnostics Expression
. el e Diagnostics Expression
Widgets 50-54 20-24
22,525,490 22,604,232 Values Expression
1
45-49 25-29 agl:Sequenc
Bar Chart 21.370.368 21,698,010 qiSequancel. ) |
-44 30-34 self.eContents()->filter(papaya::Folder)->size(),
o 20,796, q g%%'g%ég 83,639 self.eContents()->filter(papaya::Component)->size(),
Button faa self.eContents()->filter(papaya::lteration)->size()
Types Keys Expression
Checkb Frequency
e aql:Sequence{'Folder’, 'Component’, 'lteration"}
m 0.12-
DateTime 0.10-
il 0.08 -
FIex?ox 0.06 -
Container
0.04 - I I II
! nno2_ . = I- - =

% OBEO



Charts

® © @ )X Sirius Web X + v

<« > C @ localhost:5173/projects/cf307e9e-a5bc-4754-a483-c03043c9f805/edit/2b81bc93-6b92-43fa-bf94-6fb5d773e80a?selection=2b81bc93-6b92-43fa-bf94-6fb5d773e80a w o} 0

22( Papaya : > RUN COMMANDS... 2+K|| @
Sirius Web internal test project
2 ™3 Explorer El New o S = Dotails
- —
T o* L Main page Planning Charts New form
v = Papaya
v {o) Sirius Web Project Charts Core Properties

[E] New form  : Types Label
[ Data New form

3 Requirements Documentation

[ Specification

o Documentation
&P sirius-components-core

& sirius-components-representations

Description Name Papaya Form
& sirius-components-diagrams
& sirius-components-forms

5] Iteration 2025.8.0

] Iteration 2025.10.0
5] Iteration 2025.12.0

Component
4
Types
Count
4.0 -

3.5+
3.0-
2.5
2.0~
1.5-
1.0 =
0:5=
0.0

Folder Component Iteration
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Table

Y Sirius Web X + =
< C @ localhost:5173/projects/cdf5f15b-0ebf-429a-b8bf-73c84e6791b8/edit/f74be474-3bb1-4f96-9598-a6fcf460e4f5?selection=a743a474-84fa-47e7-aa8b-84694a76a950 w 5} o
Papaya : > RUN COMMANDS...
Sirius Web internal test project
®= ™3 Explorer & s diagram X = Details —
+ T &
v 'Ba Sirius Core Properties
v () Sirius Web Name

> [ nherations

> [ Tasks Concept

> [3 Contributions Description

> [ Operational Analysis =

v & Component -

fk class diagram

v @ Package

v B3 Concept : /\ Visibility
Cg name e ® PUBLIC
Cg description 8 Concept
> E: Sirius Web - Lifecycle Alisirgot
Attributes R
Static

C¢ name
Cg description

< > Attributes

£ SETTINGS
Operations
Visibility Actions
PUBLIC
@ ® description PUBLIC
vV

Learn more
Follow these links to view the code of this
Sirius Web internal test project on Github.
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Conclusion
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Form

Parameterized by a description
Large collection of widgets
Custom widgets

WYSIWYG editor

Layout & styling

Can embed charts or tables

s OBEO



Webinars

® L 9 Unlock the Power of Diagrarr X + 5

« (¢ %% youtube.com/walch?v=0QrK8h1Hxgo % bu ] wy o

= *1YouTube

F]
2 B

ca

23

* 3 Beyond Diagrams: Unlocking X +

c 25 youtube.com/watch?v=DIOtkHF2b-s o ¥ ) =5 o

-+ Create Q o

‘8 8 cID-R000a

WEBINAR S ZZZSirius
| WEB |

b 1-]: EX<L

| Beyond Diagrams:
= | Unlocking the Power of Tables

P Pl O 1553 50 EEN

s + Create

Unlock the Power of Diagram Creation with Sirius Web | Webinar by Stéphane Bégaudeau | Obeo S ® ~ W T b
L] H
- o) G il IN JIr1US = -

63 subscribers

General
Stéphane - M | -0
. End Time
Bégaudeau - . L
Obeo
=3 Pl o) 001/37:15 ¢ Introduction > . e . : by OF *w E O :] T
g .
Beyond Diagrams: Unlocking the Power of Tables in Sirius Web | DSL Modelling | Obeo
P b m From the series From Obeo_corp Co > te Pl
v g}eo;co;p s o £ Share {1 Download 3¢ clip
= /1 subscrioers A ] -
R frsirius - Unleash the Potential of Gantt, :
VRS Y, rle and Dartal Croation i -
4:: Two Days raqme- <
"""" Tee.5 Tha? SeL® Moa i1 Wed 13 Fri 15 Sun 17 Tue 19 Thu 2! Sat2) Mom 25 Wed 27 Fri29 Sun )i Tue2 Thud Sat 8 Mon 8 Wed
. o %
| -
__,l __ Speciication
pr—— |
- Coco Ceveoprent &
4 PP 263873717 + Damo of Port
Unleash the Potential of Gantt, Deck and Portal Creation with Sirius Web | Stéphane Bégaudeau | Obeo
Sirius - Webi
"; Obe?'c?{p, @52 GF > shwe L Download 3¢ Chp  [] Save - 0:::; o X
S :

v " OBEO



Webinars

Diagrams https.//www.youtube.com/watch?v=0QrK8h1Hxgo
Gantt, Deck & Portal https://www.youtube.com/watch?v=W_1D3zdGYz0
Table https://www.youtube.com/watch?v=DIOtkHF2b-s

Product tour, roadmap...

v " OBEO


https://www.youtube.com/watch?v=0QrK8h1Hxgo
https://www.youtube.com/watch?v=W_1D3zdGYz0
https://www.youtube.com/watch?v=Dl0tkHF2b-s

https://blog.obeosoft.com

(8]

blog.obeosoft.com/sirius-web-2025-8 G C

Sirius Web 2025.8

We are excited to announce the release of the version 2025.8 of !

This update introduces groundbreaking features designed to give you more control, better collaboration, and enhanced
customization. Let's dive into the details:

INTRODUCING CAPABILITIES: FINE-GRAINED Ul CONTROL

We've implemented a brand-new mechanism called capabilities, allowing you to enable or disable specific Ul functionalities.

Currently, capabilities are available for:

= Project editing, deletion, and renaming;
= Adding libraries;

= Accessing project settings.

With capabilities, as a downstream application, you can now create a restricted frontend environment. For example, a workspace
where users cannot create new projects and all projects are read-only. This is ideal for controlled environments where you want to
limit user actions while still providing access to essential features.

= Details

% !
= - Topograptyy

Core Properties i
P ,‘V—ﬂ

Label o]

> | DataSowce) Documentation

: Description Name  Topography
‘ i nl CompositeProcessor1

|/
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https://eclipse.dev/sirius/sirius-web.html

& ® LY Sirius | Sirius WebHome x + i
c 25 eclipse.dev/sirius/sirius-web.html #r 3 o

We

Sirius Desktop Sirius Web

'7 e o
+
Slrlus FEATURES  EXTENSIBILITY COMMUNITY  REFERENCES  RESOURCES [N/ EeT 1)

Central_Unit

EASILY CREATE AND
®  ® ) eclipse-sirius/sirius-web: Si' X+ DEPLOY GRAPH'CAL = § Extornal Unit
« C 2% agithub.com/eclipse-sirius/sirius-web STUD'OS To THE WEB _o m

O eclipse-sirius sirius-web An open-source low-code platform for defining custom web

applications that support your specific visual languages

Issues 699 Il Pullrequests 93 ) Discussions () Actions [I] Projects [1J Wiki 2 Security 141 |~ Insights

sirius-web rubii

master -

@ sbegaudeau [releng] Bump version t X scdeafd - 1 v E '
B .dependabot releng] Update the dabot configuration
= Graphically represent With a modern No Desktop Installation
-githu . . . .
and edit data cloud-based application Required
8 .vscode
Modeling studios It with Sirius Web support Your studios provide a modern UX and are Once de ed on a se

B doc the editing of your DSL using both your specific deployed on a web server us state-of-the-art your custom studio direc L

visual notation and native domain concepts technologies: Spring, React, PostgreSQL with no need for any specif sktop installation
BB integration-tests releng] Bump version to 20 ) GraphQL
B packages
B scripts
B vscode-extension

jus Web Product Tour: Low-Cod®
PRODUCT TOUR

irus WeBriQerijeie
.gitattributes [cleanup] it w eckout crif ¢ w2 M NUTES

[ .gitignore

The Low-code Solution fo
€ egting w "' ased

.npmrc

CHANGELOG.adoc

CONTRIBUTING Packages 273

DEPENDENCIES ler j st rt hec endencies IP 3 years ago N sirius-components-core
N sirius-components-diagrams
] Dockerrun.aws.json.template
M sirius-components-selection

) LICENSE freleng] Replace code with n sion, now part of Siriu...
1 NOTICE
Contributors 29
README.adoc
package-lock.json

] package.json

] settings.xml

] turbo.json [r e turbo to version 2.3.3 montr Languages
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How to get started?

e Download Sirius Web and run it

e See https://qgithub.com/eclipse-sirius/sirius-web

 Now available on Dockerhub &
* |ntegrate parts of Sirius Web in your own application

* Build a Sirius Web based application

s OBEO
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Obeo Enterprise for Sirius

® @ #" Obeo Enterprise For Sirius - = X + o

< C 25 obeosoft.com/en/products/obeo-enterprise-for-sirius g D o

"
., 5 O B E O SOLUTIONS PRODUCTS SERVICES RESOURCES COMPANY CAREERS CONTACT

"

Obeo Enterprise for Sirius Features References Contact us

Enterprise Collaboration
Enabler for Cloud-Native PRe = 23
Graphical Modeling N

Obeo Enterprise for Sirius brings enterprise-grade collaboration ' — £l ses *

2 v L L] i
capabilities to Sirius Web, enabling teams to collaborate efficiently on the L A

same modeling projects

Request a Quote
is an open-source technology that dramatically reduces the

time and effort required to create domain-specific modeling
l ‘ . workbenches
* Sirius Web is the web-based version of Sirius, enabling the development
of modeling studios that can be deployed to the cloud and accessed
through a web browser.

Obeo Enterprise for Sirius is a comprehensive set of complementary

features that extend Sirius Web for enterprise-grade collaboration and

scalable deployment in professional environments.

Features

Control who can connect
Welcome to Obeo Cloud Platform

With Obeo Enterprise for Sirius, only users authorized by the administrator

ron arrpce tho hnctod nrnijortc and thoir cantained meodaelc
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Obeo Enterprise for Sirius

Extension for Sirius Web based applications

Authentication (login + password, OAuth2)
Authorization (private projects, team based access control, organizations, ...)

Webhooks

And more

/
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Thank you for watching!



Questions?

s OBEO



